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1 Web License 
Overview, Set Up 
and Management

The information in this chapter is arranged into the following 
main topics:

• Kurzweil 3000 Web License Overview on page 2.

• Web License System Requirements on page 5.

• Installing Web License Client Software on page 6.

• Installing the Web License Client Using the MSI Install (IT 
Professionals) on page 7.

• Installing Microsoft Speech Platform on page 8.

• Working with User Accounts and License Allocation on page 9.

• Registering Users on page 10.

• Viewing and Managing Licenses on page 16.

• Managing Users on page 17.

• Viewing and Changing Your Personal User Information and 
Password on page 18.

• For Top Level Coordinators on page 20.
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Chapter 1. Web License Overview, Set Up and Management
Kurzweil 3000 Web License Overview
Welcome to Kurzweil 3000  Web License Edition. If you are a Web License 
user, you can access all of the program’s features from any computer that 
has Internet connection and that is running the Web License Client software. 

Kurzweil 3000 maintains personal settings, documents and work, even if you 
switch computers or go wireless.

Licenses for Using Kurzweil 3000 Over the Internet

Kurzweil 3000 Web License product offers convenient, secure Kurzweil 3000 
license check in/out through the Web.

Unlike Network Edition licenses, the storage and management of which are 
on the local network, Web licenses are stored and managed by Cambium 
Learning and delivered to users over the Internet. 

In addition to placing less of a burden on a school’s technology team, Web 
Licensing allows users to access licenses and run Kurzweil 3000 from any 
computer on which the Kurzweil 3000 Web License Client software is 
installed, and from anywhere on the Internet, while taking personal settings 
and preferences with them.

Web License Users

There are three types of users: 

• Designated License Coordinator who is set up by Cambium Learning for 
the organization. This user has the ability to create and manage sub-
users and to allot licenses to those sub-users, which can include Student 
users. When viewing user information, this user can see and change all 
of his/her sub-users’ information. When viewing Universal Library 
contents, this user can access all of his/her sub-users’ folders.

• Site coordinator who could be a teacher, principal, or other school 
authority. Set up by the organization’s license coordinator, this user has 
the ability to create and manage sub-users, including Student users, and 
to allot licenses to those sub-users. When viewing user information, the 
site coordinator/teacher user can see and change all of his/her sub-
users’ information. When viewing Universal Library contents, this user 
can access all of his/her sub-users’ folders.
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• Student users are created and registered by any user who can create 
sub-users. They cannot, however, have sub-users, nor have access 
other users’ folders in the Universal Library except Public ones created 
by their teachers or for the organization.

Complemented by Web-Based Universal Library 

Included with the Kurzweil 3000 Web License Edition is the Web Universal 
Library, a robust file repository that provides leveled access to files and 
documents. 

The Web Universal Library enables districts or schools to widely distribute 
curriculum, and share and reuse material. Any user can upload district-wide 
curriculum and resource files. Teachers are able to post classwork, and 
students can access those files and documents from anywhere on the 
Internet, from any Kurzweil 3000 Web Client computer, at any time.

The Web License Universal Library also includes the Classic Literature 
collection of nearly 2000 public domain electronic text, from literary classics, 
factbooks, and references to religious and historical documents.

For additional details about the Web Universal Library, see Chapter 2, Web 
Universal Library.

All Preferences, Customized Lists, Dictionaries and Settings Travel 
with the User

Kurzweil 3000 Web License system maintains each user’s personal 
preferences, settings and any feature that is customizable, including Toolbar 
sets, Word Lists, OCR Corrections list, and Word Prediction and Spell Check, 
dictionaries, are stored on the Kurzweil 3000 Web License server as well as 
locally on the Client computer. Upon logging in, Kurzweil 3000 checks both 
locations and uses the latest settings from either location.

Saving a Toolbar Set saves to the Web License server so that others with 
permissions can access the set.
Kurzweil 3000 for Windows Web License Guide 3
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How Does Web License Work? 

Once your organization completes the Web License product purchase 
process, an IT specialist installs the Web License Client Software, and an 
initial user account is set up by Cambium Learning Customer Service for a 
designated License Coordinator. 

That initial user, who could be a school administrator, IT specialist, even a 
teacher, then creates sub-user accounts for sub-site coordinators at different 
schools, teachers and/or students. At the time of user setup, the system 
generates login information — a username and password — for each user. 

Each user, other than Student users, can set up and manage sub-users 
under his/her account.

To access Kurzweil 3000, log in using the Kurzweil 3000 desktop icon on a 
computer running Web License Client software.

General Web License Edition Notes

Time Out: After 60 minutes of inactivity, a message appears asking if you are 
still using the program. If there is no response, Kurzweil 3000 automatically 
logs off your account. The only function available in Kurzweil 3000 is Save 
so that you can save any work. If there is an assignment in progress, 
Kurzweil 3000 automatically saves the work.
Kurzweil 3000 for Windows Web License Guide 4



Chapter 1. Web License Overview, Set Up and Management
Web License System Requirements
Processor: 1.3 GHz Pentium 4 or better

System Memory: 512 MB (1GB for 64-bit Windows Vista, Windows 7 or 
Windows 8)

Hard Disk Space: 2 GB free space

Operating System: Microsoft® XP with Service Pack 3 or later, Windows 
Vista with Service Pack 1 or later, Windows 7, or Windows 8

Video RAM: 4 MB or better

Screen Resolution: 1024x768 24-bit or better

Color Palette: 16-bit

DVD drive

Keyboard and mouse 

Sound card with speakers and microphone

TWAIN-compatible scanner or Document camera (HoverCam or SCEye)

Internet connection

Web browser: Mozilla Firefox 3.5 or later or Microsoft Internet Explorer 7 or 
later 
Kurzweil 3000 for Windows Web License Guide 5
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Installing Web License Client Software 
You may need Administrator privilege. 

1. Place the Kurzweil 3000 DVD in the computer’s DVD drive.

2. Double-click the Setup file.

3. In the Master Installation dialog, select Web Licensing Software.

4. Select Install Web Licensing Software.

5. Follow the prompts to finish installing the software. 

6. Restart if prompted to do so.

You are ready to log in to and use Web License Edition by clicking the 
Kurzweil 3000 icon.

Note: If you are an Administrator user, whenever you launch Kurzweil 3000, 
the system checks for the latest software update. If one is found, you can opt 
to do one of the following:

• Choose No to not install the update and have Kurzweil 3000 launch 
normally.

• Choose Don't Ask Me Again to disable future auto update system 
checks.

• Choose Yes to install the update now. Once the install is complete, 
Kurzweil 3000 launches.
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Installing the Web License Client Using the MSI 
Install (IT Professionals)

This option installs the Web License Client computers across your LAN from 
a central location. It is provided for network administrators who are 
knowledgeable about MSI packages and have the necessary tools to operate 
directly on an MSI package.

Microsoft .Net Framework 3.5 must already be installed before using MSI. 

You will need to specify the following arguments as properties to the Kurzweil 
3000 msi package.

AUTO = 1 (should be a numeric value)

EDITION = "web"

AUTOUPDATE = 0 sets the automatic software update to No updates; using 
1 sets automatic software update to Yes.

An example to launch Version 13 through command line follows:

msiexec.exe /i "Kurzweil 3000 v.13.msi" AUTO=1 EDITION="web"/qn 
AUTOUPDATE=0 /qn 

where /i is the install switch and /qn is the Silent UI switch.
Kurzweil 3000 for Windows Web License Guide 7



Chapter 1. Web License Overview, Set Up and Management
Installing Microsoft Speech Platform
In addition to updated OCR and NeoSpeech voices, Kurzweil 3000 Version 
13 has added support for the Microsoft Speech Platform Runtime 11 Voices. 
Microsoft Speech Platform delivers access to more than a dozen additional 
voices in a variety of languages. You can choose and adjust the many voice 
options to suit your individual preference.

Installation

Microsoft Speech Platform is included on the Kurzweil 3000 DVD in a folder 
named "MicrosoftSpeech". A setup program is provided by Microsoft which 
handles the installation.

Note: These voices are not supported by Windows XP, but can be used with 
Windows Vista, Windows 7, and Windows 8.
Kurzweil 3000 for Windows Web License Guide 8
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Working with User Accounts and License 
Allocation

After your organization purchases a number of Web Licenses, Cambium 
Learning Customer Service sets up the initial user (typically, this is a 
designated site coordinator who could be teacher, school administrator or IT 
specialist). He/she is given username and password for login.

The site coordinator/initial user can then set up the site users, providing them 
with their system-generated usernames and passwords, and allocating 
licenses.

Once that is done, any user can log in, set up, manage and distribute 
licenses to sub-users under their accounts.

Sub-users are typically teachers who set up their own sub-users, typically 
students. Student users, however, do not have User Management access.

Accessing the User Management System

Go to https://accounts.fireflybykurzweil.com and log in. 

Note: From Kurzweil 3000, you can access your firefly account by choosing 
My Account from the File menu. If you need frequent access to this link, 
consider using Tools > Customize Toolbars to place the My Account button 
on a toolbar.
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The Home page opens displaying site account information such as the 
number of licenses purchased, allocated and activated.

Along the top, right-hand area are three tabs: Home, My Account and Help. 
Log Out is in the upper-right-hand corner of the firefly window.

Registering Users

There are three ways to register sub-users under your account:

• You can use Kurzweil’s free user import and rostering service.

• You can register each user yourself using the Add Users feature.

• You can initiate self-registration and send a link to the users you want to 
self-register.

Using User Import and Rostering Service
If you purchased a site or district license, we offer a free user import and 
rostering service. It is recommended that we create your user accounts 
through this import process, instead of manually creating user accounts (a 
process that is explained in this document). To take advantage of the free 
import and rostering service, please email fireflyroster@cambiumtech.com.

Using the Add Users Feature
1. Log in. Your Home page opens (or, if you were logged on previously and 

then logged out from a different page, the Profile page for example, that 
page will open).
Kurzweil 3000 for Windows Web License Guide 10
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Chapter 1. Web License Overview, Set Up and Management
2. Hover the cursor over the My Account tab to display the menu. 

3. Select Users from the drop-down menu Your Team page will open.

4. Click the Everyone icon and when it opens, click the Add User tab. .

5. Add the user information: First Name, Last Name, Password, Email, 
School/Org, and External Id. The Student box is pre-checked. If you are 
adding a teacher, uncheck the Student box. The External ID can be any 
identifier that you want – a Student ID Number, for example. This field is 
only used as a search field. Note: if you specify a password, the 
password must be at least 5 characters with no apostrophes. All other 
Kurzweil 3000 for Windows Web License Guide 11



Chapter 1. Web License Overview, Set Up and Management
fields are required. If the user has a valid email address the login 
information is automatically emailed to the user. If the user does not have 
an email address, enter the TLC’s email address as a placeholder. You 
will then need to provide the user the login information. 

Note: If you have more than one user to enter, use the drop-down list to 
select a number of fields to add, and click Add More. The number you 
select will add that many more lines of fields. 

6. When you have finished adding users, click Save. 

The user information then appears in the Student or Teacher list on the 
Everyone page, along with the system-generated username and 
password (if you didn’t already provide one). 

Note that these usernames and passwords can also be used to login to 
the Kurzweil 3000 Web License Product and the free firefly iPad 
application that can be downloaded from https://www.kurzweiledu.com/
kurzweil-3000-firefly-ipad-app.html. 

Initiate User Self-Registration
Links to the self-registration form enable teachers and students to add 
themselves to the firefly roster. Only the top-level coordinator can initiate self-
registration. 
Kurzweil 3000 for Windows Web License Guide 12
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Chapter 1. Web License Overview, Set Up and Management
1. Hover the cursor over the My Account tab to display the menu.

2. Select Users from the drop-down menu. Your My Team page opens.

3. Click User Self-Registration. A window opens that displays a link for 
you to copy and send to teachers and a link for you to copy and send to 
students. Note: Because teachers and students have different privileges, 
it’s important to send the correct link. 
Kurzweil 3000 for Windows Web License Guide 13
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4. Click Copy next to the appropriate link (Teacher self-registration or 
Student self-registration). 

5. Open your email application and address an email to the teachers or 
students you want to self-register. 

6. In the message section of the email, paste the link you copied from the 
self-registration window.

7. Send.

The recipient will click the link in the email they’ve received and the User Self-
Registration form will display.
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After filling in the information and clicking the Add New button, a “Success” 
message will display that includes the username, password, and a link to the 
login form.
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Viewing and Managing Licenses

To view license information:

1. Hover the cursor over the My Account tab and choose Users from the 
drop-down menu. Open any of the Everyone pages (Student, Teachers, 
or Add Users) or your Team page. 

2. At the top of the page you can find:

• Total Licenses: the total number of licenses for your site.

• Allocated Licenses: the number of licenses distributed among users.

• Remaining Licenses: the number of licenses remaining; that is the Total 
Licenses minus the Allocated Licenses.
Kurzweil 3000 for Windows Web License Guide 16
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Managing Users

To Update User Information:

1. Hover the cursor over the My Account tab and choose Users from the 
drop-down menu. Click your Team icon. 

2. Locate the user to be updated. Note that lists can be sorted alphabetically 
in ascending or descending order by selecting the down or up arrows at 
the top of each column. You can also use any of the search fields at the 
top of the list. t.

3. All the text fields can be edited. Place your cursor in a field that needs 
updating and start typing. The line of fields is outlined in yellow and you’ll 
notice that the Save button is activated. Note: To change the password, 
click the Show link beneath the Password column heading. 

4. Click Save when you have finished making changes. Note that these 
changes will appear on the Everyone list and on any Team page the user 
information appears. 
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To Remove a User from Your Team: 

Only a TLC can delete a user, but you can remove a user from your Team 
page. The user will still exist on the Everyone list. 

1. Hover the cursor over the My Account tab and choose Users from the 
drop-down menu. 

2. Click your Team or the Everyone icon. 

3. Find the user that you want to remove from your Team and click the 

Remove button to the right of the user information if you are on your 
Team page or uncheck the checkbox to the right of the user information 
if you are on the Everyone page. Either of these actions will remove the 
user from your Team page. 

Viewing and Changing Your Personal User Information and 
Password

To view and change your own user information, including password:

1. Hover the cursor over My Account to display the menu, then click 
Profile.
Kurzweil 3000 for Windows Web License Guide 18
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The Manage Profile page includes user information such as address 
and occupation, login, and school/organization information.

2. Make the desired changes.

3. Then click Update Account Information.

Forgot Password?

1. Click the Forgot Password in the log in page.

2. In the Forgot Password? page, enter the email address associated with 
your account.

3. Your username and the original password will be emailed to you.

4. Use the emailed password to log in.

5. Go to and follow the instructions in To view and change your own user 
information above.
Kurzweil 3000 for Windows Web License Guide 19
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For Top Level Coordinators

Only a Top Level Coordinator (TLC) can delete a user. Later, if needed, the 
TLC can restore that user. Notice that the TLC Coordinator has an additional 
icon: Restore Users. 

To Delete a User 

1. Log in as TLC. 

2. Open the Everyone Page. In the right column you will notice a trash can 
icon next to each user in the list.

3. Click the Delete icon next to each user that you want to delete. 
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To Restore Users 

There are times when the TLC may need to restore a user that was deleted. 
To Restore a User: 

1. Click the Restore Users button. A list of Users who were previously 
removed is displayed. 

2. Click the Restore button in the right column next to each user that you 
want to restore. 

The user(s) will be restored to the Everyone list
Kurzweil 3000 for Windows Web License Guide 21



2 Web Universal 
Library 

The information in this chapter is arranged into the following 
topics.

• The Web Universal Library Overview on page 23.

• Web Universal Library Structure on page 23.

• Using the Web Universal Library on page 25.

• To open a document from the Library: on page 25.

• To save an open document to the Library: on page 26.

• To create a new folder: on page 27.

• To cut, copy, delete, rename a folder or file: on page 28.

• To view file properties: on page 29.
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The Web Universal Library Overview
Kurzweil 3000 Web License Edition includes the Web Universal Library. If 
your school uses the Kurzweil 3000 Local Area Network (LAN) Universal 
Library, you are already aware of the benefits of central file storage and 
sharing.

The Kurzweil 3000 Web Universal Library, however, is an expanded version 
of the LAN Universal Library. Because the Web Universal Library is Internet-
based, it allows students and teachers, or any authorized users, using any 
computer running Web License Client software from anywhere on the World 
Wide Web, to access and share files.

For districts and schools, the Web Universal Library is ideal for placing 
standardized curriculum material and print resources in electronic form for all 
or for specific groups to access. Teachers can make class files available 
wherever, whenever students need them.

Included in each Web Universal Library are the following folders: 

• Classic Literature, a collection of nearly 2000 books, historical 
documents selected from the public domain

• Samples, files from Cambium Learning Group's published educational 
series, LANGUAGE!, Learning A-Z and Passport Reading Journeys.

Web Universal Library Structure

The structure of the Universal Library is based on user/sub-user file system 
concept where each authorized user can set up and manage his/her sub-
users.

In addition to sub-user folders, each user also has a Public folder and a 
Private folder. All users have Read-Write permission to his/her own and to 
sub-users’ Public and Private folders

Sub-users only have Read access to the Public folder of the user who 
created their account.

For example, a district could set up folders for each school. In a school's 
folder, there could be folders for teachers as well as a Public and a Private 
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folder. All teachers and students in the school could access the school’s 
Public folder. Teachers would not be able to access one another’s folders. 

Each teacher folder in turn would have the teacher’s students' folders, plus a 
Public and Private folder. All students whose accounts a teacher creates 
would be able to access their teacher’s Public folder. Students would not be 
able to access one another’s folders.
Kurzweil 3000 for Windows Web License Guide 24
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Using the Web Universal Library
You can open and save to the Universal Library and manage folders and files 
by using either the Open from the Universal Library or Save to the Universal 
Library.

The Web Universal Library currently supports KES, TXT, DOC, DOCX, RTF, 
HTM, HTML, and TIF file formats.

To open a document from the Library:

1. From the File menu, choose Open from Library.

2. In the Open from the Universal Library dialog, in the left-hand pane, 
click the folder from which you want to open a file. You may have to open 
subfolders. In the example below a subfolder in the Classic Literature 
folder is selected in the left-hand pane; its content files are listed in the 
right-hand pane., 

3. In the right-hand pane, select the file you want.

4. Click Open.

Notes: 

• No user can save files to the Universal Library Classic Literature folder.

• You can also search for a Classic Literature file by using Online Search; 
for more information, go to online Help.
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To save an open document to the Library:

1. Open the document you want to save to the library.

2. From the File menu, choose Save to Universal Library to open the 
Save to the Universal Library dialog.

3. In the dialog, do the following: 

Specify where you want to place the file by clicking the desired folder in 
the left-hand pane.

(Optional) If you want to create a new folder in which to save this 
document, click the New Folder button in the upper right-hand corner.

(Optional) Change the file name. Note that only lowercase letters, 
numerals and underscores are permitted in file/folder names.

(Optional) Specify another file format.

4. Click Add.

Notes: 

• When saving a file, you are essentially uploading it to the Web server, 
and the time and speed by which a file is uploaded depend on the Internet 
line and service that your site is using. Generally, we recommend 50 
pages or fewer per file, so if you have a rather large text book, it's a good 
idea to separate the chapters and save a chapter at a time.

• No user can save files to the Universal Library Classic Literature folder.
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To create a new folder:

You can only create a new folder under your or your sub-users’ folders.

1. From the File menu, choose either Open from Library or Save to 
Library.

2. In the dialog, in the left-hand pane, click the folder in which you want to 
place the new folder.

3. There are a few places where you can find the New Folder command:

In the left-hand pane, open the Right Mouse Button menu and choose 
New Folder.

In the right-hand pane, open the Right Mouse Button menu and choose 
New Folder.

Or in the upper right-hand corner, click the New Folder button.

4. Type the name of the folder in the Folder Name box that appears. Note 
that only lowercase letters, numerals and underscores are permitted in 
file/folder names.

5. Click Add.
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To cut, copy, delete, rename a folder or file:

Note that you can only cut, copy, delete, rename a folder or file under your or 
your sub-users’ folders. In addition, only lowercase letters, numerals and 
underscores are permitted in file/folder names.

1. From the File menu, choose either Open from Library or Save to 
Library.

2. In the dialog, do one of the following:

For a folder: Select the folder in the left-hand pane.

For a file: First, in the left-hand pane, select the folder in which the file(s) 
are located. Next, select the file(s) from the right-hand pane.

3. Right-click to open the Right Mouse Button menu and choose the 
command you want. The menu below is the File Right Mouse Button 
menu. The Folder menu is similar, but does not have Properties.
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Chapter 2. Web Universal Library
To view file properties:

1. From the File menu, choose Open from Universal Library.

2. In the dialog, in the left-hand pane, select the folder in which the file is 
located. Next, select the file from the right-hand pane.

3. Right-click to open the Right Mouse Button menu. Select Properties to 
open the File Properties dialog.

4. Click OK.
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